
Chapter 20

The User Coordinate
System

After completing this chapter, you will be able to:
• Understand the conventions in AutoCAD LT.
• Understand the concept of the world coordinate system (WCS).
• Understand the concept of the user coordinate system (UCS).
• Control the display of the UCS icon using the UCSICON command.
• Change the current UCS icon type using the UCSICON command.
• Use the UCS command.
• Understand different options of changing the UCS using the UCS command.
• Manage the UCS through a dialog box using the UCSMAN command.
• Understand the different system variables related to the UCS and the UCS icon.

Learning Objectives
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Figure 20-1  Figure showing the orientation of the fingers

CONVENTIONS IN AutoCAD LT
Before starting with the user coordinate, it is important for you to know the conventions in
AutoCAD LT. AutoCAD LT follows these three conventions:

1. Whenever you open a new drawing in AutoCAD LT, it is in the plan view and whatever
you draw, it will be in the world XY plane using the world coordinate system.

2. The right-hand rule is followed in AutoCAD LT to identify the X, Y, and Z axes directions.
The right-hand rule states that if you keep the thumb, index finger, and the middle
finger of the right hand mutually perpendicular to each other as shown in Figure 20-1,
then the thumb of the right hand displays the direction of the positive X axis, the index
finger displays the direction of the positive Y axis and the middle finger of the right
hand displays the direction of the positive Z axis (Figure 20-2).

3. The right-hand thumb rule is followed in AutoCAD LT to determine the direction of rota-
tion in the 3D space. It is very difficult to specify the clockwise or the counterclockwise
direction in the 3D space and, therefore, the right-hand thumb rule is followed. The
right-hand thumb rule states that if the thumb of the right hand displays the direction of
the axis of rotation, then the direction of the curled fingers will define the positive direction
of rotation. See Figure 20-3.
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Figure 20-2  Figure showing the orientation of the X, Y, and Z axes

This rule will be used during the rotation of UCS.

WORLD COORDINATE SYSTEM (WCS)
As discussed earlier, when you start a new AutoCAD LT drawing, by default, the world
coordinate system (WCS) is established. The objects you have drawn until now use the WCS.
In the WCS, the X, Y, and Z coordinates of any point are measured with reference to the fixed
origin (0,0,0). This origin is located at the lower left corner of the screen by default. This
coordinate system is fixed and cannot be moved. The WCS is generally used in 2D drawings,
wireframe models, and surface models. However, it is not possible to create a solid model
keeping the origin and the orientation of the X, Y, and Z axes at the same place. The reason

Figure 20-3  Figure showing the axis and direction of rotation
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Menu: View > Display > UCS Icon
Command: UCSICON

for this is that in case you want to create a feature on the top face of an existing model, you can
do it easily by shifting the working plane using the Elevation option of the ELEV command
(Figure 20-4). But in case you want to create a feature on the faces other than the top and the
bottom faces of an existing model, it is not possible using the ELEV command (Figure 20-5).

Note
The ELEV command is discussed in Chapter 21, Drawing and Viewing 3D Objects.

This problem can be solved using a concept called the user coordinate system (UCS). The
UCS allows you to relocate and reorient the origin and X, Y, and Z axes and establish your
own coordinate system depending upon your requirement. The UCS is mostly used in 3D
drawings, where you may need to specify points that vary from each other along the X, Y, and
Z axes. It is also useful for relocating the origin or rotating the XY axes in 2D work such as
ordinate dimensioning, drawing auxiliary views, or controlling hatch alignment. The UCS
can be modified using the UCSICON and the UCS commands.

CONTROLLING THE VISIBILITY OF THE UCS ICON

This command is used to control the visibility and the location of the UCS icon. The UCS icon
is a geometric representation of the current X, Y and Z axes direction. AutoCAD LT displays
different UCS icons in model space and paper space as shown in Figure 20-6 and Figure 20-7.
By default the UCS icon is displayed near the bottom left corner of the drawing area. You can
change the location and visibility of this icon using the UCSICON command.

The following prompt sequence is issued when you invoke this command.

Enter an option [ON/OFF/All/Noorigin/ORigin/Properties] <ON>:

Figure 20-5  Creating a feature on the side faceFigure 20-4  Creating a feature on the top face
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ON
This option is used to display the UCS icon on the screen.

OFF
This option is used to make the UCS icon invisible from the screen. The UCS icon will no
longer be displayed on the screen. You can again turn on the display of the UCS icon using
the On option of the UCSICON command.

All
This option is used to apply the changes to UCS icons in all the active viewports. If this
option is not used, the changes will be applied only to the current viewport.

Noorigin
This option is used so that the UCS icon is displayed at the lower left corner of the viewport
irrespective of the actual location of the origin of the current UCS.

ORigin
This option is used to place the UCS icon at the origin of the current UCS.

Properties
When you invoke this option, the UCS Icon dialog box will be displayed as shown in
Figure 20-8. The options provided in this dialog box are discussed next.

Figure 20-7  Paper space UCS iconFigure 20-6  Model space UCS icon
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Figure 20-9  2D UCS icon at the World position

UCS icon style Area
2D. If this radio button is selected, the 2D UCS icon will be displayed on the screen instead of
the 3D UCS icon. Figure 20-9 shows a 2D UCS icon.

3D. If this radio button is selected, the 3D
UCS icon will be displayed on the screen. This
is the default option and AutoCAD LT displays
the 3D UCS icon by default.

Cone. If this check box is cleared, the cones
at the end of the X and Y axes of the 3D UCS
icon will not be displayed. Instead, the arrows
will be displayed.

Line width. This drop-down list provides the
width values that can be assigned to the 3D
UCS icon. The default value for the line width
is 1. This drop-down list will not be available if the 2D radio button is selected.

UCS icon size Area
The slider bar provided in this area is used to increase the size of the UCS icon. You can also
enter the value of the size of the UCS icon directly in the edit box, but the value of the UCS icon
size can vary between 5 and 95. The default value of the size of the UCS icon is 12.

UCS icon color Area
This area provides the drop-down lists that are used to change the color of the UCS icon in the
Model space as well in the Layout tab. By default, the color in the Model space is black and in
the Layout is blue. You can assign any desired colors to the UCS icon. By default there are seven

Figure 20-8  The UCS Icon dialog box
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colors that are available in these drop-down lists. However, you can also select the desired color
from the Select Color dialog box. This dialog box will be displayed if you select More from the
Model space icon color or the Layout tab icon color drop-down list.

DEFINING NEW UCS

The UCS command (Figure 20-10) is used to set a new
coordinate system by shifting the working plane (XY plane) to
the desired location. For certain views of the drawing it is
better to have the origin of measurements at some other point on or relative to your drawing
objects. This makes locating the features and dimensioning the objects easier. The change in the
UCS can be viewed by the change in the position and orientation of the UCS icon, that is by
default placed at the lower left corner of the drawing window. The origin and orientation of a
coordinate system can be redefined using the UCS command. The prompt sequence is given
next.

Command: UCS
Current ucs name:  *WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/?/World]<World>: Select
an option.

If the UCSFOLLOW system variable is set to 0, any change in the UCS does not affect the
drawing view.

W (World) Option
With this option, you can set the current UCS back to the world coordinate system,
which is the default position. When the UCS is placed at the world position, a small
rectangle is displayed at the point where all three axes meet in the UCS icon

(see Figure 20-11). If the UCS is moved from its default position, this rectangle is no longer
displayed indicating that the UCS is not at the world position as shown in Figure 20-12.

Tip
In case you have selected the 2D UCS instead of the 3D UCS icon, the W will not be displayed
if the UCS is not at the world position.

N (New) Option
The New option is used to define a new UCS by using various suboptions provided under this
option. The prompt sequence is given next.

Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/?/World]<World>: N
Specify origin of new UCS or [ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>:

Toolbar: UCS
Menu: Tools > New UCS
Command: UCS

Figure 20-10  The UCS toolbar
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Figure 20-14  Relocating UCS to the new originFigure 20-13  Defining a new origin for the UCS

O (Origin) Option
This option is used to define a new UCS by changing the origin of the current UCS.
The directions of the X, Y, and Z axes remain unaltered. The new point defined will
now be the origin point (0,0,0) for all the coordinate entries from this point on, until

the origin is changed again. You can specify the coordinates of the new origin or simply pick it
on the screen using the pointing device. The prompt sequence that will follow when you choose
this button is given next.

Specify new origin point <0,0,0>: Specify the origin point as shown in Figure 20-13.

Figure 20-14 shows the UCS after defining a new UCS origin.

Tip
If you do not provide a Z coordinate for the origin, the Z coordinate is assigned the current
elevation value.

Figure 20-12  UCS not at the world positionFigure 20-11  UCS at the world position
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Note
The Origin, ZAxis, 3points, OBject, Face, View, X, Y and Z options can also be invoked by
entering N at the Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/?/
World]<World>: prompt.

ZA (ZAxis) Option
This option is used to change the coordinate system by selecting the origin point of the
XY plane and a point on the positive Z axis. After you specify a point on the Z axis,
AutoCAD LT determines the X and Y axes of the new coordinate system accordingly.

The prompt sequence that will follow when you choose this button is given next.

Specify new origin point <0,0,0>: Specify the origin point as shown in Figure 20-15.
Specify point on positive portion of Z-axis <default>: @0,-1,0

The front face of the model will now become the new work plane (Figure 20-16) and all the new
objects will be oriented accordingly. If you give a null response for the Specify point on the
positive portion of Z axis <current> prompt, the Z axis of the new coordinate system will be
parallel to (in the same direction as) the Z axis of the previous coordinate system. Null responses
to the origin point and the point on the positive Z axis establish a new coordinate system in
which the direction of the Z axis is identical to that of the previous coordinate system; however,
the X and Y axes may be rotated around the Z axis. The positive Z axis direction is also known
as the extrusion direction.

3 (3point) Option
With this option you can establish a new coordinate system by specifying a new origin
point, a point on the positive side of the new X axis, and a point on the positive side of
the new Y axis (Figure 20-17). The direction of the Z axis is determined by applying the

right-hand rule. The 3point option of the UCS command changes the orientation of the UCS to
any angled surface. The prompt sequence that will follow when you choose this button is given
next.

Figure 20-16  Relocating the UCS using the ZA
option

Figure 20-15  Specifying a point on origin
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Specify new origin point <0,0,0>: Specify the origin point of the new UCS.
Specify point on positive portion of X-axis <1.0000,0.0000,0.0000>: Specify a point on the
positive portion of the X axis.
Specify point on positive-Y portion of the UCS XY plane <0.0000,1.0000,0.0000>: Specify
a point on the positive portion of the Y axis.

A null response to the Specify new origin point <0,0,0> prompt will lead to a coordinate
system in which the origin of the new UCS is identical to that of the previous UCS. Similarly,
null responses to the Point on the X or Y axis prompt will lead to a coordinate system in which
the X or Y axis of the new UCS is parallel to that of the previous UCS. In Figure 20-18, the
UCS has been relocated by specifying three points (the origin point, a point on the positive
portion of the X axis, and a point on the positive portion of the Y axis).

In this example, you will draw a tapered rectangular block. After drawing it, you will align the
UCS on the inclined face of the block using the 3point option of the UCS command. Then you
will draw a circle at the inclined face. The dimensions for the block and the circle are given in
Figure 20-19.

This problem can be broken into the following steps.

• Draw the edges on the bottom face of the tapered block.
• Draw the edges on the top face of the tapered block.
• Draw the remaining edges of the block.
• Align the UCS on the inclined face.
• Draw the circle on the inclined face.

Figure 20-18  UCS at new positionFigure 20-17  Relocating the UCS using three
points

Example 1
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Creating the model using these steps is discussed next.

1. Open a new drawing and choose the Line button from the Draw toolbar. The prompt
sequence is as follows.

Specify first point: 1,1
Specify next point or [Undo]: @10,0
Specify next point or [Undo]: @0,8
Specify next point or [Close/Undo]: @-10,0
Specify next point or [Close/Undo]: C

2. The top face of the model is at a distance of 8 units from the bottom face, in the positive
Z direction. Therefore, you will have to define a UCS at a distance of 8 units to create the
top face. This can be done by choosing the Origin UCS button from the UCS toolbar.
The prompt sequence is as follows.

Specify new origin point <0,0,0>: 0,0,8

3. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point: 1,1
Specify next point or [Undo]: @6,0
Specify next point or [Undo]: @0,8
Specify next point or [Close/Undo]: @-6,0
Specify next point or [Close/Undo]: C

4. By default, when you open a new drawing, you view the model from the top view. Therefore,
when viewing from the top, the three edges of the top side overlap with the corresponding

Figure 20-19  Model for Example 1
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Figure 20-22  Model after aligning the UCS on the inclined face

bottom edges. Therefore, you will not be able to see them. However, you can change the
viewpoint to clearly view the model in 3D. Choose the SE Isometric View button from the
View toolbar to proceed to the SE isometric view. You can now see the 3D shape of the
objects. See Figure 20-20.

5. Join the remaining edges of the model using the Line button. The model, after joining all
the edges, should look similar to the one shown in Figure 20-21.

6. Now, you have to draw the circle at the inclined face. But to draw the circle at the inclined
face, you will have to make the inclined face as the current working plane. Therefore, choose
the 3 Point UCS button from the UCS toolbar. The prompt sequence is as follows.

Specify new origin point <0,0,0>: Select point P1 as shown in Figure 20-22.
Specify point on positive portion of X-axis <default>: Select point P2 as shown in Figure 20-22.
Specify point on positive-Y portion of the UCS XY plane <default>: Select point P3 as shown
in Figure 20-22.

Figure 20-20  3D view of the objects Figure 20-21  Model after joining all the edges
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7. Choose the Circle button from the Draw toolbar and draw the circle at the inclined face.

8. The final model should look similar to the one shown in Figure 20-23.

OB (OBject) Option
With the OB (OBject) option of the UCS command, you can establish a new coordinate
system by pointing to any object in an AutoCAD LT drawing. However, the objects that
can not be used as an object for defining a UCS are a 3D polyline, 3D mesh, viewport

object, or xline. The positive Z axis of the new UCS is in the same direction as the positive Z axis
of the object selected. If the X and Z axes are given, the new Y axis is determined by the
right-hand rule. The prompt sequence that will follow when you choose this button is given
next.

Select object to align UCS: Select the object to align the UCS.

In Figure 20-24, the UCS is relocated using the OBject option and is aligned to the circle. The
origin and the X axis of the new UCS are determined by the following rules.

Arc. When you select an arc, its center becomes the origin for the new UCS. The X axis passes
through the endpoint of the arc that is closest to the point selected on the object.

Circle/Ellipse. The center of the circle becomes the origin for the new UCS, and the X axis
passes through the point selected on the object (Figure 20-25).

Line/Dline/Ray/Leader. The new UCS origin is the endpoint of the line nearest the point
selected on the line. The X axis is defined so that the line lies in the XY plane of the new UCS.
Therefore, in the new UCS the Y coordinate of the second endpoint of the line is 0.

Figure 20-23  Final model for Example 1
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Tip
The linear edges of the regions are considered as individual lines when selected to align a UCS.

Spline. The origin of the new UCS is the endpoint of the spline that is nearest to the
point selected on the spline. An imaginary line will be drawn between the two endpoints of the
spline and the X axis will be aligned along this imaginary line.

Dimension. The middle point of the dimension text becomes the new origin. The X axis
direction is identical to the direction of the X axis of the UCS that existed when the dimension
was drawn.

Point. The position of the point is the origin of the new UCS. The direction of the X, Y, and Z
axes will be same as those of the previous UCS.

Solid. The origin of the new UCS is the first point of the solid. The X axis of the new UCS lies
along the line between the first and second points of the solid.

2D Polyline. The start point of the polyline or polyarc is treated as the new UCS origin. The X
axis extends from the start point to the next vertex.

Shape/Text/Insert/Attribute/Attribute definition. The insertion point of the object becomes
the new UCS origin. The new X axis is defined by the rotation of the object around its positive
Z axis. Therefore, the object you select will have a rotation angle of zero in the new UCS.

Tip
The XY plane of the new UCS will be parallel to the XY plane existing when the object was
drawn; however, X and Y axes may be rotated.

F (Face) Option
This option aligns the new UCS with the selected face of the solid object. The prompt
sequence that will follow when you choose this button is:

Figure 20-25  UCS at a new locationFigure 20-24  Relocating the UCS using a circle
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Select face of solid object: Select the face to align the UCS.
Enter an option [Next/Xflip/Yflip] <accept>:

The Next option, locates the new UCS on the next, adjacent face or the back face of the selected
edge. Xflip rotates the new UCS by 180-degree about the X axis and Yflip rotates it about the Y
axis. Pressing ENTER at the Enter an option [Next/Xflip/Yflip] <accept> accepts the location
of the new UCS as specified.

V (View) Option
The V (View) option of the UCS command lets you define a new UCS whose XY plane
is parallel to the current viewing plane. The current viewing plane in this case is the
screen of the monitor. Therefore, a new UCS is defined that is parallel to the screen of

the monitor. The origin of the UCS defined in this option remains unaltered. This option is
used mostly to view a drawing from an oblique viewing direction or for writing the text for the
objects on the screen. As soon as you choose this button, a new UCS is defined parallel to the
screen of the monitor.

X/Y/Z Options
With these options, you can rotate the current UCS around a desired axis. You can specify the
angle by entering the angle value at the required prompt or by selecting two points on the screen
with the help of a pointing device. You can specify a positive or a negative angle. The new angle
is taken relative to the X axis of the existing UCS. The UCSAXISANG system variable stores the
default angle by which the UCS is rotated around the specified axis, by using the X/ Y/ Z
options of the New option of the UCS command. The right-hand thumb rule is used to determine
the positive direction of rotation of the selected axis.

X Option
In Figure 20-26, the UCS is relocated using the X option by specifying an angle about
the X axis. The first model shows the UCS setting before the UCS was relocated and the

Figure 20-26  Figure showing UCS rotated about the X axis
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second model shows the relocated UCS. The prompt sequence that will follow when you choose
this button is given next.

Specify rotation angle about X axis <90>: Specify the rotation angle.

Y Option
In Figure 20-27, the UCS is relocated using the Y option by specifying an angle about
the Y axis. The first model shows the UCS setting before the UCS was relocated and the
second model shows the relocated UCS. The prompt sequence that will follow when you

choose this button is given next.

Specify rotation angle about Y axis <90>: Specify the angle.

Z Option
In Figure 20-28, the UCS is relocated using the Z option by specifying an angle about
the Z axis. The first model shows the UCS setting before the UCS was relocated and the
second model shows the relocated UCS. The prompt sequence that will follow when you

choose this button is given next.

Specify rotation angle about Y axis <90>: Specify the angle.

Tip
Rotation about the Z axis can be used as an alternative to using the SNAP command to rotate
the snap and grid.

M (Move) Option
This option redefines the UCS by moving the UCS Origin in the positive or negative
direction along the Z axis with respect to the current UCS Origin. The orientation of

Figure 20-27  Figure showing UCS rotated about the Y axis
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the XY plane remains the same. Remember that this button is not available in the UCS toolbar.
Instead, this button is available in the UCS II toolbar. The prompt sequence that will follow
when you choose this button is given next.

Specify new origin point or [Zdepth]<0,0,0>: Specify the point or the depth.

If you enter a point at the previously mentioned prompt, then the origin of the current UCS is
moved to the specified point. The prompt sequence that will follow when you enter Z at this
prompt is given next.

Specify Zdepth<0>: Specify the depth in the Z axis direction.

The Zdepth option specifies the distance by which the UCS origin moves along the Z axis.
When you use the Move UCS option, in case there are multiple viewports in the drawing, the
change in the UCS is applied only to the current viewport. Note that the Move option is not
added to the Previous list.

G (Orthographic) Option
This option allows you to set current any one of the six
Orthographic UCSs provided with AutoCAD LT. They
are Top, Bottom, Front, Back, Left, and Right. You can
specify any one of these UCSs by selecting from the
UCS II toolbar drop-down list of predefined UCSs
(Figure 20-29). The Orthographic UCSs are used
normally when one is viewing and editing models.

Figure 20-28  Figure showing UCS rotated about the Z axis

Figure 20-29  Selecting orthographic
UCS from the UCS II toolbar
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The Orthographic UCSs are set with respect to the WCS. The UCSBASE system variable controls
the UCS upon which the orthographic settings are based, and the initial value is the world
coordinate system.

P (Previous) Option
The P (Previous) option restores the current UCS settings to the previous UCS settings.
The last ten user coordinate system settings are saved by AutoCAD LT. You can go back
to the previous ten UCS settings in the current space using the Previous option. If

TILEMODE is off, the last ten coordinate systems in paper space and in model space are saved.
When you choose this button, the previous UCS settings are automatically restored. If you have
changed the default UCS, the Previous options is added to the drop-down list available in the
UCS II toolbar also.

R (Restore) Option
With this option of the UCS command, you can restore a previously saved named UCS. Once a
saved UCS is restored, it becomes the current UCS. The viewing direction of the saved UCS is
not restored. You can also restore a named UCS by selecting it from the UCS II toolbar drop-down
list. Because this option does not have a button for it, you have to invoke this option using the
UCS button in the UCS toolbar. The prompt sequence that will follow when you choose the UCS
button is:

Current ucs name:  *WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/?/World] <World>: R
Enter name of UCS to restore or [?]:

You can specify the name of the UCS to be restored or list the UCSs that can be restored by
pressing ENTER at the previously mentioned prompt. The prompt sequence that will be
followed is:

Enter UCS name(s) to list <*>: Specify the name of the UCS to list or give a null response to list
all the available UCSs.

If you give a null response at the previously mentioned prompt, then the AutoCAD LT text
window will be opened listing all the available UCSs.

S (Save) Option
With this option, you can name and save the current UCS settings. When you are naming the
UCS, remember the following:

1. The name can be up to 255 characters long.
2. The name can contain letters, digits, blank spaces, and the special characters $ (dollar),

- (hyphen), and _ (underscore).
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This option also does not have a button. Therefore, this option will be invoked using the UCS
button in the UCS toolbar. The prompt sequence that will follow when you choose the UCS
button is:

Current ucs name:  *WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/?/World] <World>: S
Enter name to save current UCS or [?]:

Enter a valid name for the UCS at this prompt and AutoCAD LT saves it as a UCS. You can also
list the previously saved UCSs by pressing ENTER at this prompt. The next prompt sequence is:

Enter UCS name(s) to list <*>:

Enter the name of the UCS to list or give a null response to list all the available UCSs.

D (Delete) Option
The D (Delete) option is used to delete the selected UCS from the list of saved coordinate
systems. This option also does not have a button. Therefore, this option will be invoked using
the UCS button in the UCS toolbar. The prompt sequence that will follow when you choose the
UCS button is:

Current ucs name:  *WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/?/World]<World>: D
Enter UCS name(s) to delete <none>: Specify the name of the UCS to delete.

The UCS name you enter at this prompt is deleted. You can delete more than one UCS by
separating the UCS names with commas or by using wild cards. If you delete a UCS that is
current, it is renamed to UCS Unnamed.

? Option
By invoking this option, you can list the name of the specified UCS. This option gives you the
name, origin, and X, Y, and Z axes of all of the coordinate systems relative to the existing UCS.
If the current UCS has no name, it is listed as WORLD or UNNAMED. The choice between
these two names depends on whether the current UCS is the same as the WCS. Choose the UCS
button to invoke this option. The prompt sequence that will follow is:

Current ucs name:  *WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/?/World] <World>: ?
Enter UCS name(s) to list <*>:
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MANAGING UCS THROUGH DIALOG BOX

The UCSMAN command displays the UCS dialog box (Figure 20-30). This dialog box
can be used to restore the saved and orthographic UCSs, specify UCS icon settings, and
rename UCSs. This dialog box has three tabs: the Named UCSs tab, the Orthographic

UCSs tab, and the Settings tab.

Named UCSs Tab
The list of all the coordinate systems defined (saved) on your system is displayed in the list box
of this tab. After the list of all user defined coordinate syatems, the first entry in this list is
World, which means the world coordinate system. The next entry is Previous. Selecting the
Previous entry and then choosing the OK button repeatedly enables you to go backward through
the coordinate systems defined in the current editing session. Unnamed is the next entry in the
list if you have not named the current coordinate system. If there are a number of viewports and
unnamed settings then only the current viewport UCS name is displayed in the list. The current
coordinate system is indicated by a small pointer icon to the left of the coordinate system name.
The current UCS name is also displayed next to Current UCS. If you want to make some other
coordinate system current, select that coordinate system name in the UCS Names list, and then
choose the Set Current button. To delete a coordinate system, select that coordinate system
name, and then right-click to display a shortcut menu. The options are Set Current, Rename,
Delete, and Details. Choose the Delete button to delete the selected UCS name. To rename a
coordinate system, select that coordinate system name, and then right-click to display the shortcut

Figure 20-30 The Named UCSs tab of the UCS dialog box

Toolbar: UCS > Named UCS
UCS II > Named UCS

Menu: Tools > Named UCS
Command: UCSMAN
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menu and choose Rename. Now, enter the desired new name. You can also double-click the
name to be modified and then change the name.

Tip
All the changes and updating of the UCS information in the drawing are carried out only after
you choose the OK button.

If you want to check the current coordinate system’s origin and X, Y, and Z axis values, select a
UCS from the list and then choose the Details button. The UCS Details dialog box (Figure 20-31)
containing that information is displayed. You can also choose Details from the shortcut menu
displayed when you right-click a specific UCS name in the list box.

Setting UCS to Preset Orthographic UCSs Using the
Orthographic UCSs Tab
The UCS dialog box with the Orthographic UCSs tab is displayed also on choosing Orthographic
UCS > Preset from the Tools menu. You can select any one of the preset orthographic UCSs
from the list in the Orthographic UCSs tab of the UCS dialog box (Figure 20-32). Selecting Top
and choosing the Set Current button results in creation of the UCS icon in the top view, also
known as the plan view. You can double-click on the UCS name you want to set as current to
make it current. You can also right-click the specific orthographic UCS name in the list and
choose Set Current from the shortcut menu displayed. The Current UCS displays the name of
the current UCS name. If the current settings have not been saved and named, the Current
UCS name displayed is Unnamed.

The Depth column in the list box of this dialog box displays the distance between the XY plane
of the selected orthographic UCS setting and a parallel plane passing through the origin of the
UCS base setting. The system variable UCSBASE stores the name of the UCS which is considered
the base setting; that is, it defines the origin and orientation. You can enter or modify values of
Depth by double-clicking the depth value of the selected UCS in the list box to display the

Figure 20-31 The UCS Details dialog box
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Orthographic UCS depth dialog box (Figure 20-33), where you can enter new depth values. You
can also right-click a specific orthographic UCS in the list box to display a shortcut menu.
Choose Depth to display the Orthographic UCS depth dialog box. The edit box available in
this dialog box depends on the orthographic UCS that you select. For example, if you double-click
on the depth of the bottom orthographic UCS, the name of the edit box will be Bottom Depth
edit box. Enter a value in the Bottom Depth edit box or choose the Select new origin button to
specify a new origin or depth on the screen.

In the Orthographic UCSs tab of the UCS dialog box, you are given the choice of establishing
a new UCS relative to a named UCS or to the WCS. This choice is offered from the Relative to
drop-down list. This list lists all the named UCSs in the current drawing. By default World is
the base coordinate system. If you have set current any one of the preset orthographic UCSs and
the you select a UCS other than World in the Relative to drop-down list, the Current UCS
changes to Unnamed. Choosing the Details button, displays the UCS Details dialog box with
the origin and the X, Y, Z coordinate values of the selected UCS. You can also choose Details
from the shortcut menu that is displayed on right-clicking a UCS in the list box. The shortcut
menu also has a Reset option. Choosing Reset from the shortcut menu restores the origin of the
selected orthographic UCS to its default location (0,0,0).

Figure 20-33 The Orthographic UCS depth dialog box

Figure 20-32  Orthographic UCSs tab of the UCS dialog box
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Settings Tab
The Settings tab of the UCS dialog box (Figure 20-34) displays and modifies UCS and UCS
icon settings of a specified viewport.

UCS Icon settings Area
Selecting the On check box displays the UCS icon in the current viewport. It is similar to using
the UCSICON command to set the display of the UCS icon to on or off. If you select the
Display at UCS origin point check box, the UCS icon is displayed at the origin point of the
coordinate system in use in the current viewport. If the origin point is not visible in the current
viewport or if the check box is cleared, the UCS icon is displayed in the lower left corner of the
viewport. Selecting the Apply to all active viewports check box applies the current UCS icon
settings to all active viewports in the current drawing.

UCS settings Area
When you select the Update view to plan view when UCS is changed check box, the plan view
is restored when the UCS in the viewport is changed. Also, when the selected UCS is restored,
the plan view is restored. The value is stored in the UCSFOLLOW system variable.

SYSTEM VARIABLES
The coordinate value of the origin of the current UCS is held in the UCSORG system variable.
The X and Y axis directions of the current UCS are held in the UCSXDIR and UCSYDIR
system variables, respectively. The name of the current UCS is held in the UCSNAME variable.
All these variables are read-only. If the current UCS is identical to the WCS, the WORLDUCS
system variable is set to 1; otherwise, it holds the value 0. The current UCS icon setting can be
examined and manipulated with the help of the UCSICON system variable. This variable holds

Figure 20-34  Settings tab of the UCS dialog box
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the UCS icon setting of the current viewport. If more than one viewport is active, each one can
have a different value for the UCSICON variable. If you are in paper space, the UCSICON
variable will contain the setting for the UCS icon of the paper space. The UCSFOLLOW system
variable controls the automatic display of a plan view when you switch from one UCS to another.
If UCSFOLLOW is set to 1, a plan view is automatically displayed when you switch from one
UCS to another. The UCSAXISANG variable stores the default angle value for the X, Y, or Z axis
around which the UCS is rotated using the X, Y, Z options of the New option of the UCS
command. The UCSBASE variable stores the name of the UCS that acts as the base; that is, it
defines the origin and orientation of the orthographic UCS setting. The UCSVP variable decides
whether the UCS settings are stored with the viewport or not.

Answer the following questions and then compare your answers to those given at the end of
this chapter.

1. The world coordinate system can be moved from its position. (T/F)

2. The View option of the New option of the UCS command allows you to define a new UCS
whose XY plane is parallel to the current viewing plane. (T/F)

3. The ellipse can not be used as an object for defining a new UCS. (T/F)

4. If you do not specify the Z coordinates of the new point while moving the UCS, the previous
Z coordinates will be taken for the new value. (T/F)

5. By default the __________ is established as the coordinate system in the AutoCAD LT
environment.

6. The __________ coordinate system can be moved and rotated to any desired location.

7. Once a saved UCS is restored, it becomes the __________ UCS.

8. The __________ command controls the display of the UCS icon.

9. You can change the 3D UCS icon to a 2D UCS icon using the __________ option of the
UCSICON command.

10. The __________ point of the 3D face defines the origin of the new UCS.

Self-Evaluation Test



The User Coordinate System      20-25

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Answer the following questions.

1. The insertion point of an attribute becomes the origin of the new UCS. (T/F)

2. The line width of the UCS icon can be changed. (T/F)

3. The size of the UCS icon can vary between 5 to 100. (T/F)

4. The name of the current UCS is stored in the UCSNAME variable. (T/F)

5. Which option is used to restore the previous UCS settings?

(a) ZAxis (b) Restore
(c) Previous (d) Save

6. Which option is used to list the names of all the saved UCSs?

(a) ZAxis (b) Restore
(c) ? (d) Save

7. Which variable is used to control the automatic display of the plan view when you switch to
the new UCS?

(a) UCSORG (b) UCSFOLLOW
(c) UCS (d) UCSBASE

8. Which variable stores the coordinates of the origin of the current UCS?

(a) UCSICON (b) UCSORG
(c) UCSVP (d) UCSFOLLOW

9. Which command is used to manage the UCS using a dialog box?

(a) UCS (b) UCSMAN
(c) UCSICON (d) UCSBASE

10. The __________ option of the UCS command is used to change the origin of the current
UCS.

11. The __________ direction is known as the extrusion direction.

12. The lineweight of the UCS icon can be changed using the __________ option of the
UCSICON command.

13. The __________ variable is used to control the X axis direction of the current UCS.

Review Questions
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Figure 20-35  Model for Exercise 1

14. The __________ variable is used to control the Y axis direction of the current UCS.

15. The __________ variable is used to store the default angle value by which the UCS will be
rotated using the X, Y and Z option of the New option UCS command.

In this exercise, you will draw the model shown in Figure 20-35. Assume the missing dimensions
for the model.

Create the drawings shown in Figure 20-36 and Figure 20-37. Assume the missing dimensions
for the model. Use the UCS command to align the ucsicon and then draw the objects.

Exercises

Exercise 1 Mechanical

Exercises 2 and 3 Mechanical
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Create the drawings shown in Figure 20-38 and Figure 20-39. Assume the missing dimensions
for the model. Use the UCS command to align the ucsicon and then draw the objects.

Create the drawing shown in Figure 20-40. Assume the missing dimensions for the model. Use
the UCS command to align the ucsicon and then draw the objects. The left side of the transition
makes a 90-degree angle with the bottom.

Figure 20-36  Drawing for Exercise 2 Figure 20-37  Drawing for Exercise 3

Exercises 4 and 5 Mechanical

Figure 20-38  Drawing for Exercise 4 Figure 20-39  Drawing for Exercise 5

Exercise 6 General
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Exercise 7 General

Figure 20-41  Model for Exercise 7

Create the drawings shown in Figure 20-41. Assume the missing dimensions for the model. Use
the UCS command to position the ucsicon and then draw the objects. The center of the top
polygon is offset 0.75 units from the center of the bottom polygon

.
Answers to Self-Evaluation Test
1 - F, 2 - T, 3 - F, 4 - T, 5 - world coordinate system, 6 - user, 7 - current,
8 - UCSICON, 9 - Properties, 10 - first

Figure 20-40  Model for Exercise 6


